BACnet Gateway-3

Installation and Operation Manual
Fire Alarm System Limitations

While a fire alarm system may lower insurance rates, it is not a substitute for fire insurance!

An automatic fire alarm system—typically made up of smoke detectors, heat detectors, manual pull stations, audible warning devices, and a fire alarm control panel with remote notification capability—can provide early warning of a developing fire. Such a system, however, does not assure protection against property damage or loss of life resulting from a fire.

The Manufacturer recommends that smoke and/or heat detectors be located throughout a protected premises following the recommendations of the current edition of the National Fire Protection Association Standard 72 (NFPA 72), manufacturer’s recommendations, State and local codes, and the recommendations contained in the Guide for Proper Use of System Smoke Detectors, which is made available at no charge to all installing dealers. These documents can be found at http://www.systemsensor.com/html/applicat.html.

A study by the Federal Emergency Management Agency (an agency of the United States government) indicated that smoke detectors may not go off in as many as 35% of all fires. While fire alarm systems are designed to provide early warning against fire, they do not guarantee warning or protection against fire. A fire alarm system may not provide timely or adequate warning, or simply may not function, for a variety of reasons:

Smoke detectors may not sense fire where smoke cannot reach the detectors such as in chimneys, in or behind walls, on roofs, or on the other side of closed doors. Smoke detectors also may not sense a fire on another level or floor of a building. A second-floor detector, for example, may not sense a first-floor or basement fire.

Particles of combustion or “smoke” from a developing fire may not reach the sensing chambers of smoke detectors because:

- Barriers such as closed or partially closed doors, walls, or chimneys may inhibit particle or smoke flow.
- Smoke particles may become “cold,” stratify, and not reach the ceiling or upper walls where detectors are located.
- Smoke particles may be blown away from detectors by air outlets.
- Smoke particles may be drawn into air returns before reaching the detector.

The amount of “smoke” present may be insufficient to alarm smoke detectors. Smoke detectors are designed to alarm at various levels of smoke density. If such density levels are not created by a developing fire at the location of detectors, the detectors will not go into alarm.

Smoke detectors, even when working properly, have sensing limitations. Detectors that have photo-electronic sensing chambers tend to detect smoldering fires better than flaming fires, which have little visible smoke. Detectors that have ionizing-type sensing chambers tend to detect fast-flaming fires better than smoldering fires. Because fires develop in different ways and are often unpredictable in their growth, neither type of detector is necessarily best and a given type of detector may not provide adequate warning of a fire.

Smoke detectors cannot be expected to provide adequate warning of fires caused by arson, children playing with matches (especially in bedrooms), smoking in bed, and violent explosions (caused by escaping gas, improper storage of flammable materials, etc.).

Heat detectors do not sense particles of combustion and alarm only when heat on their sensors increases at a predetermined rate or reaches a predetermined level. Rate-of-rise heat detectors may be subject to reduced sensitivity over time. For this reason, the rate-of-rise feature of each detector should be tested at least once per year by a qualified fire protection specialist. Heat detectors are designed to protect property, not life.

IMPORTANT! Smoke detectors must be installed in the same room as the control panel and in rooms used by the system for the connection of alarm transmission wiring, communications, signaling, and/or power. If detectors are not so located, a developing fire may damage the alarm system, crippling its ability to report a fire.

Audible warning devices such as bells may not alert people if these devices are located on the other side of closed or partly open doors or are located on another floor of a building. Any warning device may fail to alert people with a disability or those who have recently consumed drugs, alcohol or medication. Please note that:

- Strobes can, under certain circumstances, cause seizures in people with conditions such as epilepsy.
- Studies have shown that certain people, even when they hear a fire alarm signal, do not respond or comprehend the meaning of the signal. It is the property owner’s responsibility to conduct fire drills and other training exercise to make people aware of fire alarm signals and instruct them on the proper reaction to alarm signals.
- In rare instances, the sounding of a warning device can cause temporary or permanent hearing loss.

A fire alarm system will not operate without any electrical power. If AC power fails, the system will operate from standby batteries only for a specified time and only if the batteries have been properly maintained and replaced regularly.

Equipment used in the system may not be technically compatible with the control panel. It is essential to use only equipment listed for service with your control panel.

Telephone lines needed to transmit alarm signals from a premise to a central monitoring station may be out of service or temporarily disabled. For added protection against telephone line failure, backup radio transmission systems are recommended.

The most common cause of fire alarm malfunction is inadequate maintenance. To keep the entire fire alarm system in excellent working order, ongoing maintenance is required per the manufacturer’s recommendations, and UL and NFPA standards. At a minimum, the requirements of NFPA 72 shall be followed. Environments with large amounts of dust, dirt or high air velocity require more frequent maintenance. A maintenance agreement should be arranged through the local manufacturer’s representative. Maintenance should be scheduled monthly or as required by National and/or local fire codes and should be performed by authorized professional fire alarm installers.
Installation Precautions

Adherence to the following will aid in problem-free installation with long-term reliability:

**WARNING** - Several different sources of power can be connected to the fire alarm control panel. Disconnect all sources of power before servicing. The control unit and associated equipment may be damaged by removing and/or inserting cards, modules, or interconnecting cables while the unit is energized. Do not attempt to install, service, or operate this unit until this manual is read and understood.

**CAUTION** - System Reacceptance Test after Software Changes. To ensure proper system operation, this product must be tested in accordance with NFPA 72 after any programming operation or change in site-specific software. Reacceptance testing is required after any change, addition or deletion of system components, or after any modification, repair or adjustment to system hardware or wiring.

All components, circuits, system operations, or software functions known to be affected by a change must be 100% tested. In addition, to ensure that other operations are not inadvertently affected, at least 10% of initiating devices that are not directly affected by the change, up to a maximum of 50 devices, must also be tested and proper system operation verified.

**This system** meets NFPA requirements for operation at 0°C to 49°C (32°F to 120°F) and at a relative humidity 93% ± 2% RH (non-condensing) at 32°C ± 2°C (90°F ± 3°F). However, the useful life of the system’s standby batteries and the electronic components may be adversely affected by extreme temperature ranges and humidity. Therefore, it is recommended that this system and all peripherals be installed in an environment with a nominal room temperature of 15-27°C/60-80°F.

**Verify that wire sizes are adequate** for all initiating and indicating device loops. Most devices cannot tolerate more than a 10% I.R. drop from the specified device voltage.

**Like all solid state electronic devices** this system may operate erratically or can be damaged when subjected to lightning-induced transients. Although no system is completely immune from lightning transients and interferences, proper grounding will reduce susceptibility. Overhead or outside aerial wiring is not recommended, due to an increased susceptibility to nearby lightning strikes. Consult with the Technical Services if any problems are anticipated or encountered.

**Disconnect AC power and batteries** prior to removing or inserting circuit boards. Failure to do so can damage circuits.

**Remove all electronic assemblies** prior to any drilling, filing, reaming, or punching of the enclosure. When possible, make all cable entries from the sides or rear. Before making modifications, verify that they will not interfere with battery, transformer, and printed circuit board location.

**Do not tighten screw terminals** more than 9 in-lbs. Over-tightening may damage threads, resulting in reduced terminal contact pressure and difficulty with screw terminal removal.

**Though designed to last many years**, system components can fail at any time. This system contains static-sensitive components. Always ground yourself with a proper wrist strap before handling any circuits so that static charges are removed from the body. Use static-suppressive packaging to protect electronic assemblies removed from the unit.

**Follow the instructions** in the installation, operating, and programming manuals. These instructions must be followed to avoid damage to the control panel and associated equipment. FACP operation and reliability depend upon proper installation by authorized personnel.

---

**FCC Warning**

**WARNING:** This equipment generates, uses, and can radiate radio frequency energy and if not installed and used in accordance with the instruction manual, may cause interference to radio communications. It has been tested and found to comply with the limits for class A computing device pursuant to Subpart B of Part 15 of FCC Rules, which is designed to provide reasonable protection against such interference when operated in a commercial environment. Operation of this equipment in a residential area is likely to cause interference, in which case the user will be required to correct the interference at his own expense.

**Canadian Requirements:** This digital apparatus does not exceed the Class A limits for radiation noise emissions from digital apparatus set out in the Radio Interference Regulations of the Canadian Department of Communications. This Class A digital apparatus complies with Canadian ICES-003.

Le présent appareil numérique n'émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la classe A prescrites dans le Règlement sur le brouillage radioélectrique édicté par le ministère des Communications du Canada. Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.
Documentation Feedback

Your feedback helps us keep our documentation up-to-date and accurate. If you have any comments, you can email us.

Please include the following information:

• Product name and version number (if applicable)
• Manual page number
• Your comment

Send email messages to:

FireSystems.TechPubs@honeywell.com

Please note this email address is for documentation feedback only. If you have any technical issues, please contact Technical Services.
Table of Contents

Section 1 NOTIFIER® BACnet Gateway-3 Features ................................................................. 7
  1.1: Product Description ......................................................................................................... 7
  1.1.1: BACnet GW-3 Features ............................................................................................ 7
  1.2: Related Documentation ................................................................................................. 8
    Table 1.1 Related Documentation .................................................................................. 8
  1.3: Agency Listings ............................................................................................................. 8
    1.3.1: Compliance ........................................................................................................... 8
    1.3.2: Installation ........................................................................................................... 9
  1.4: Environmental Requirements ....................................................................................... 9
  1.5: Compatibility ................................................................................................................ 10
  1.6: Upgrade Information .................................................................................................. 10
  1.7: System Requirements ................................................................................................. 10
  1.8: System Architecture .................................................................................................. 11
    1.8.1: Single Panel Architecture .................................................................................... 11
    Figure 1.1 BACnet GW-3 Single Panel Diagram ......................................................... 11
    1.8.2: NFN Network Architecture ............................................................................... 11
    Figure 1.2 Notifier System Example 1 - A Single NFN Network ................................. 12
    Figure 1.3 Notifier System Example 2 - Multiple NFN Networks ............................... 13

Section 2 BACnet GW-3 Embedded Installation ..................................................................... 15
  2.1: Required Equipment .................................................................................................... 15
  2.2: BACnet GW-3 Installation Overview ......................................................................... 16
    2.2.1: Gateway Installation Process Overview Flow Diagram .................................. 16
    Figure 2.1 Gateway Installation Process Flow Diagram ............................................. 16
    2.2.2: BACnet GW-3 Board Layout ............................................................................. 17
    Figure 2.2 BACnet GW-3 Board ................................................................................. 17
  2.3: Installing a CAB3/CAB4 Cabinet ................................................................................ 18
    Figure 2.3 CAB-3/CAB-4 Series Installation Document, 15330 .................................. 18
  2.4: Installing a CHS-4L Chassis ...................................................................................... 19
    Figure 2.4 Installing a Chassis ..................................................................................... 19
  2.5: Installing the BACnet GW-3 Board .......................................................................... 20
    Figure 2.5 Install BACnet GW-3 Board onto Chassis ................................................ 20
    2.5.1: BACnet GW-3 Power Supply Connection ...................................................... 20
    Table 2.1 Power Supply Specifications ...................................................................... 20
    Figure 2.6 BACnet GW-3 Power Connection ............................................................ 21
    2.5.2: Wiring Restrictions ............................................................................................ 21
    2.5.3: Installing the Network Communication Module ............................................. 22
    Table 2.2 Network Communication Module Details ................................................ 22
    Figure 2.7 HS-NCM Installation Document PN 54014 ............................................... 22
    Figure 2.8 NCM Installation Document PN 51533 ..................................................... 22
  2.6: Connecting BACnet GW-3 to an IP Network ............................................................ 23
    Figure 2.9 IP Cable Connection ................................................................................. 23
  2.7: Connecting BACnet GW-3 to an NFN Network or High Speed NFN Network ........... 23

Section 3 BACnet GW-3 Configuration and Operation ......................................................... 25
  3.1: BACnet GW-3 Configuration .................................................................................... 25
    3.1.1: BACnet GW-3 Configuration Overview ......................................................... 25
    3.1.2: BACnet Gateway Configuration Tool Installation ........................................... 25
    3.1.3: Connect the Configuration Computer to the BACnet GW-3 ........................... 26
    3.1.4: Prepare the Configuration Computer to Communicate with BACnet GW-3 ....... 26
    3.1.5: Log into the BACnet GW-3 for Configuration ................................................ 27
    3.1.6: Configure the BACnet GW-3 .......................................................................... 28
    3.1.7: Viewing BACnet GW-3 Activity with the BACNet Gateway Configuration Tool .................................................................................. 33
  3.2: Connect the BACnet GW-3 to the NFN Network or FACP ...................................... 33
Table 3.1 BACnet GW-3 to Fire System Connection Options.............................................................34
3.2.1: Connecting BACnet GW-3 to a High Speed NFN Network Control Module ........................35
  Figure 3.1 USB Connection ........................................................................................................35
  Figure 3.2 NUP to NUP Connection .........................................................................................36
3.2.2: Connecting BACnet GW-3 to an NFN Network Control Module ....................................37
  Figure 3.3 NUP to NUP Connection .........................................................................................37
3.2.3: Connecting BACnet GW-3 Directly to a Fire Alarm Control Panel ..................................38
  Figure 3.4 NUP to NUP Connection .........................................................................................38
3.3: Back Up BACnet GW-3 .........................................................................................................38
3.4: Restore BACnet GW-3 ..........................................................................................................39
3.5: BACnet GW-3 Operation .......................................................................................................40
  3.5.1: About BACnet GW-3 Start Up .......................................................................................40
Appendix A: PIC Statement ........................................................................................................41
  A.1: BACnet Protocol Implementation Conformance Statement (Normative) ..........................41
Appendix B: BACnet GW-3 Compatible Node Types ...........................................................................47
  B.1: Direct Connect Node Type Compatibility ..........................................................................47
  Table B.1 Panel Communication Connection Table ..................................................................47
Appendix C: BACnet GW-3 Local Configuration ...........................................................................49
  C.1: Direct Connection to the Gateway Board ...........................................................................49
  Figure C.1 Configuration Computer Direct Connection ............................................................49
  Table C.1 Cross Over Cable (568B) ...........................................................................................50
Appendix D: Glossary .........................................................................................................................51
Index ..................................................................................................................................................53
Section 1 NOTIFIER® BACnet Gateway-3 Features

1.1 Product Description

The NOTIFIER® BACnet Gateway-3 (BACnet GW-3) provides a communication link between networks that use the BACnet communication protocol and Fire Alarm Control Panels (FACP) resident on an NFN network or high speed NFN network. The BACnet GW-3 acts like any other node on an NFN network or high speed NFN network. The NFN network communicates with the gateway through an HS-NCM-W/SF/MF or NCM-W/F network control module that is on that NFN network or through a direct connection to a single NOTIFIER® panel. The BACnet communication protocol is an American National Standard (ANSI/ASHRAE 135-1995).

The BACnet GW-3 application represents physical fire devices as BACnet objects and manages the object database. As events occur, the object properties are updated in real-time, and messages are sent to the appropriate BACnet report destination (BACnet computer clients are computers with the graphical user interface workstation front end). BACnet clients may make requests to read properties of the BACnet objects. Those properties are the values of the device status and programming. The user subscribes to Event Notification objects per FACP, and the BACnet device receives events from objects on the FACP as a result of this subscription.

The BACnet client workstation front end must conform to BACnet Standard Annex J for IP and support Device Objects, Binary Output Objects, and Multi-state Input or Life Safety Points/ Zones. It is also required to write to Notification Objects and receive confirmed/unconfirmed event notification messages. For details, refer to Appendix A, “PIC Statement”, on page 41.

The BACnet GW-3 Configuration Tool, an offline programming utility that is included with the BACnet GW-3 assembly when ordered, is used to configure the BACnet GW-3. It is installed onto a computer that will be used to configure the gateway. Refer to “BACnet GW-3 Configuration” on page 27.

1.1.1 BACnet GW-3 Features

Below are some of the features of the BACnet GW-3.

- Multiple Gateways can be used for large networks (greater than 15 panels/15,000 objects).
- Use of ethernet port for BACnet GW-3 configuration with the BACnet GW-3 Configuration Tool.

NOTE: This manual is written with the understanding that its user is trained in BACnet operations and services. The information provided here is solely for the configuration of the Gateway to communicate event information to an existing BACnet network.
1.2 Related Documentation

Below is a list of documentation that relates to the use of the BACnet GW-3.

<table>
<thead>
<tr>
<th>For information on</th>
<th>Refer to</th>
<th>Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compatible Devices</td>
<td>Device Compatibility Document</td>
<td>15378</td>
</tr>
<tr>
<td>Cabinets &amp; Chassis</td>
<td>CAB-3/CAB-4 Series Installation Document</td>
<td>15330</td>
</tr>
<tr>
<td>Offline Programming Utility</td>
<td>Veri•Fire™ Tools on-line help file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Veri•Fire™ Medium Systems on-line help file</td>
<td>VeriFire-TCD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VeriFire-CD</td>
</tr>
<tr>
<td>VeriFire-TCD Networking</td>
<td>NFN Manual</td>
<td>51584</td>
</tr>
<tr>
<td></td>
<td>NCM-W/F Installation Document</td>
<td>51533</td>
</tr>
<tr>
<td></td>
<td>HS-NCM-W/SF/MF Installation Document</td>
<td>54014</td>
</tr>
<tr>
<td></td>
<td>MIB Media Interface Board Manual</td>
<td>50255</td>
</tr>
<tr>
<td>Panels and Annunciators</td>
<td>NFS-320 Installation/Operation/Programming Manual</td>
<td>52745/52746/52747</td>
</tr>
<tr>
<td></td>
<td>NFS-640 Installation/Operation/Programming Manual</td>
<td>52544/52545/52546</td>
</tr>
<tr>
<td></td>
<td>NFS2-640 Installation/Operation/Programming Manual</td>
<td>52741/52742/52743</td>
</tr>
<tr>
<td></td>
<td>NFS-3030 Installation/Operation/Programming Manual</td>
<td>51330/51344/51345</td>
</tr>
<tr>
<td></td>
<td>NFS2-3030 Installation/Operation/Programming Manual</td>
<td>52544/52546/52545</td>
</tr>
<tr>
<td></td>
<td>Network Control Annunciator (NCA) Manual</td>
<td>51482</td>
</tr>
<tr>
<td></td>
<td>Network Control Annunciator-2 (NCA-2) Manual</td>
<td>52482</td>
</tr>
<tr>
<td></td>
<td>Network Control Station (NCS) Manual</td>
<td>51095</td>
</tr>
<tr>
<td></td>
<td>AM2020/ AFP1010 Installation, Operation, and Programming Manual</td>
<td>15088</td>
</tr>
<tr>
<td></td>
<td>DVC Series Digital Voice Command Manual</td>
<td>52411</td>
</tr>
</tbody>
</table>

1.3 Agency Listings

NOTE:
UL 864, 9th Edition—Notifier systems work with products that have been UL 864, 9th Edition listed as well as products that have not received UL 864, 9th Edition certification. Operation of systems that are comprised of equipment that is UL 864, 9th Edition listed together with products that are not UL 864, 9th Edition listed requires the approval of the local Authority Having Jurisdiction (AHJ).

CAN/ULC-S559-04, 1st Edition—Notifier systems work with products that have been CAN/ULC-S559-04, 1st Edition listed as well as products that have not received CAN/ULC-S559-04, 1st Edition certification. Operation of systems that are comprised of equipment that is CAN/ULC-S559-04, 1st Edition listed together with products that are not CAN/ULC-S559-04, 1st Edition listed requires the approval of the local Authority Having Jurisdiction (AHJ).

1.3.1 Compliance

This product has been investigated to, and found to be in compliance with the following standards.

National Fire Protection Association

- NFPA 72—National Fire Alarm Code

Underwriters Laboratories

- UL-864—Control Units for Fire Alarm Systems, Ninth Edition
- UL-2017—General-Purpose Signaling Devices and Systems, First Edition

Underwriters Laboratories Canada

1.3.2 Installation

This product is intended to be installed in accordance with the following regulatory agencies.

**Local**
- AHJ—Authority Having Jurisdiction

**National Fire Protection Association**
- NFPA 70—National Electrical Code
- NFPA 72—National Fire Alarm Code

**Underwriters Laboratories**
- UL-1076—In certified applications, the unit shall be installed in accordance with Proprietary Burglar Alarm Units and Systems, Fifth Edition

**Underwriters Laboratories Canada**
- C22.1-98—Canadian Electrical Code, Part I (Twentieth Edition), Safety Standard for Electrical Installation
- CAN/ULC-S524-06—Standard for the installation of Fire Alarm Systems, Fifth Edition
- CAN/ULC-S561-03—Installation and Services for Fire Signal Receiving Centres and Systems, First Edition

---

**WARNING: Installation**

Improper installation, maintenance, and lack of routine testing could result in system malfunction.

---

**About Ethernet Network Installations**

“Listed for the purpose” has been formally interpreted by NFPA (Formal Interpretation 72-99-1) for equipment on packet switched networks as being listed to the requirements applicable to general purpose communications network equipment.

For ULC applications, the Internet cannot be used for either primary or ancillary functionality.

“Listed for the purpose” has been formally interpreted by NFPA (Formal Interpretation 72-99-1) for equipment on packet switched networks as being listed to the requirements applicable to general purpose communications network equipment.

For ULC applications, the Internet cannot be used for either primary or ancillary functionality.

---

1.4 Environmental Requirements

This product must be installed in the following environmental conditions:

- Temperature range of 0°C to 49°C (32°F - 120°F).
- 93% humidity non-condensing at 30°C (86°F).

The contents of this manual are important and must be kept in close proximity of the hardware. If building ownership is changed, this manual and all other testing and maintenance information must also be passed to the current owner of the facility. A copy of this manual was shipped with the equipment and is also available from the manufacturer.

---

**NOTE:** Refer to Appendix A, "PIC Statement", on page 41 for the BACnet PIC statement.
1.5 Compatibility

NOTE: The BACnet GW-3 requires that at least one node on the NFN network be an ONYX series panel. BACnet GW-3 does not run on an NFN network with no ONYX series panels.

Refer to Appendix B, “BACnet GW-3 Compatible Node Types”, on page 47 for supported panels and annunciators.

1.6 Upgrade Information

Firmware for systems running BACnet GW-3 versions prior to 3.11 should not be upgraded unless there is an ONYX series panel on the system. BACnet GW-3 does not run on an NFN network with no ONYX series panels.

1.7 System Requirements

The BACnet GW-3 can monitor up to fifteen panels, but the combined object count across the monitored panels cannot exceed 15,000 objects. This includes all detectors, monitor modules, control modules, bell circuits, etc. Refer to the NFN network manual for details about wiring limitations.

The computer on which the BACnet GW-3 Configuration Tool is installed should be Windows 2000 or Window XP. The computer must communicate with the BACnet GW-3 over IP or through a crossover cable from the BACnet GW-3 ethernet port.
1.8 System Architecture

NOTE: The BACnet GW-3 client workstation is not intended as a primary annunciator and is ancillary in nature.

These are connection options for the BACnet GW-3 architecture.
An Internet or Intranet IP network connection is used with both architectures.

1.8.1 Single Panel Architecture

Direct panel connection; a connection is made directly to a supported NOTIFIER® panel or annunciator (Figure 1.1 on page 11). Refer to Appendix B, “BACnet GW-3 Compatible Node Types”, on page 47 for supported panels and annunciators.

![Figure 1.1 BACnet GW-3 Single Panel Diagram]

1.8.2 NFN Network Architecture

NFN network connection; a NUP connection is made to an NCM or HS-NCM board on the NFN network as the BACnet GW-3 (Figure 1.2 on page 12)
Figure 1.2 Notifier System Example 1- A Single NFN Network
Figure 1.3  Notifier System Example 2 - Multiple NFN Networks
2.1 Required Equipment

The BACnet GW-3 requires the following:

**BACnet GW-3 Assembly**

The following are shipped with the BACnet GW-3:

- BACnet GW-3 board
- PNET-1 surge suppressor (P/N PNET-1)
- NUP to NUP Cable (P/N 75556)—used to connect the BACnet GW-3 board to an HS-NCM-W/SF/MF board or NCM-W/F board and supported panel
- USB Cable (P/N 75665)—used to connect the BACnet GW-3 board to an HS-NCM-W/SF/MF board
- Wire Leads to NUP Network Communications Module power cable (P/N 75583)

**Network Components**

- RJ45 to RJ45 standard Ethernet network cable—customer’s internet or intranet connection to BACnet GW-3
- Workstation v3.11 or above (sold separately)
- NFN network—version 5.0 or above (sold separately)
- High Speed Network Communications Module: HS-NCM-W/SF/MF board—used to facilitate network communication between the BACnet GW-3 and a High Speed NFN network (sold separately) **OR**
- Network Communications Module: NCM-W/F board—used to facilitate network communication between the BACnet GW-3 and an NFN network (sold separately).

**Cabinet and Hardware (sold separately)**

- CAB-3/CAB-4 series cabinet
- CHS-4L chassis

**Customer Supplied Equipment**

- A computer to run the BACNet Gateway Configuration Tool and configure the BACnet GW-3. Contact Technical Support for software version compatibility.
2.2 BACnet GW-3 Installation Overview

CAUTION: Multiple BACnet GW-3 Installations
BACnet GW-3s must be installed and configured one at a time because all BACnet GW-3s use the same predefined IP address and node number.

2.2.1 Gateway Installation Process Overview Flow Diagram

![Gateway Installation Process Flow Diagram]

Figure 2.1 Gateway Installation Process Flow Diagram
2.2.2 BACnet GW-3 Board Layout

Figure 2.2 BACnet GW-3 Board
2.3 Installing a CAB3/CAB4 Cabinet

Install a new CAB-3/CAB-4 series cabinet according to the requirements of the local authority having jurisdiction or prepare an existing CAB-3/CAB-4 series cabinet that houses a supported NOTIFIER® panel or annunciator. Refer to Appendix B, “BACnet GW-3 Compatible Node Types”, on page 47 for list of supported panels and annunciators.

**NOTE:** The CAB3/CAB4 cabinet is ordered separately. For installation details, refer to the CAB-3/CAB-4 Series Installation Document, 15330 and or the panel’s or annunciator’s documentation.

**NOTE:** Knockouts are provided on the unit so that the field wiring may be run in conduit if required by the local authority having jurisdiction. All field wiring connections are intended to be made at the installation wiring terminals provided as part of the unit.

---

**Figure 2.3** CAB-3/CAB-4 Series Installation Document, 15330
2.4 Installing a CHS-4L Chassis

The CHS-4 chassis is mounted with two self-threading screws (PN 36120) provided with the backbox or with two box nuts (PN 36047) provided with the chassis.

The CHS-4 chassis fits into the RS-25 cabinet and the CAB/3/CAB-4 Series cabinets, A-size through D-size.

The chassis can fit into any of the CAB-3/CAB-4 series cabinet rows except for the bottom row, which was designed for battery housing and does not have PEM rails for mounting.

**Figure 2.4 Installing a Chassis**
2.5 Installing the BACnet GW-3 Board

Install BACnet GW-3 board onto the mounting studs on the CHS-4L chassis, making sure to use only the mounting holes bordered by grounding area.

Grounding area

Figure 2.5 Install BACnet GW-3 Board onto Chassis

NOTE: There must be enough clearance on the right side of the printed circuit board to allow an Ethernet cable to be connected to the Ethernet port.

2.5.1 BACnet GW-3 Power Supply Connection

The BACnet GW-3 requires +24VDC @450mA nominal and supervised battery backup in accordance with local code requirements. Outside Canada, the BACnet GW-3 can be powered by any regulated, UL 1481 listed, power limited, battery backed, +24 VDC power supply. For Canadian installation, The BACnet GW-3 must be powered by a ULC listed Fire Alarm Control Unit or a ULC listed power supply for fire application. Conform to UL or ULC standards as applicable in your area.

Table 2.1 Power Supply Specifications

<table>
<thead>
<tr>
<th>NOMINAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Voltage</td>
</tr>
<tr>
<td>+24VDC</td>
</tr>
<tr>
<td>Input Current @ +24VDC</td>
</tr>
<tr>
<td>450 mA without NCM or HS-NCM</td>
</tr>
</tbody>
</table>

Grounding area
2.5.2 Wiring Restrictions

NOTE: All wiring connections are supervised and power limited.

NOTE: USB and NUP wiring connections to the HS-NCM must be located within 20 feet and encased in conduit within the same room.

NOTE: In Canada, if the gateway is installed in a separate cabinet, the cabinet must be connected to the Fire Alarm Control Panel (FACP) with a close nipple fitting.

RS232 (NUP)
- Line Impedance 5k ohm
- Max Distance 50 feet

Ethernet
- Line Impedance 100 ohm
- Max Distance 100 meters
USB
- Line Impedance 90 ohm ±15%
- Max Distance 40 meters

2.5.3 Installing the Network Communication Module

Install the type of network communication module you will use (whether high speed or not, wire or fibre) onto the chassis in the new CAB3/CAB4 cabinet or an existing panel’s or annunciator’s cabinet.

Table 2.2 Network Communication Module Details

<table>
<thead>
<tr>
<th>HIGH SPEED NFN NETWORKS—USE HS-NCM ONLY</th>
<th>NFN NETWORKS—USE NCM ONLY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the High Speed Network Control Module circuit board configuration that fits your installation needs.</td>
<td></td>
</tr>
<tr>
<td>• HS-NCM-W with twisted pair wire</td>
<td></td>
</tr>
<tr>
<td>• HS-NCM-SF with single mode fiber-optic cable</td>
<td></td>
</tr>
<tr>
<td>• HS-NCM-MF with multimode fiber-optic cable</td>
<td></td>
</tr>
<tr>
<td>Use the Control Module circuit board configuration that fits your installation needs.</td>
<td></td>
</tr>
<tr>
<td>• NCM-W with twisted pair wire</td>
<td></td>
</tr>
<tr>
<td>• NCM-F with fiber-optic cable</td>
<td></td>
</tr>
</tbody>
</table>

Figure 2.8 NCM Installation Document
PN 51533

BE SURE TO INSTALL THE CORRECT SPEED NETWORK CONTROL MODULE, BASED ON WHETHER YOU HAVE AN NFN NETWORK OR A HIGH SPEED NFN NETWORK.
2.6 Connecting BACnet GW-3 to an IP Network

This allows the BACnet GW-3 to communicate through your IP network (Internet or Intranet)

Step 1. Plug the PNET-1 surge suppressor into the BACnet GW-3 board Ethernet connector.
Step 2. Plug the RJ45 cable into the PNET-1.
Step 3. Plug the RJ45 cable into your IP network.

![Diagram of IP Cable Connection]

**NOTE:** The Ethernet wire must be connected through the PNET-1 surge suppressor.

**NOTE:** The Ethernet port is power limited.

2.7 Connecting BACnet GW-3 to an NFN Network or High Speed NFN Network

The BACnet GW-3 should not be connected to the NFN network until after it has been properly configured. For more information, please refer to Section 3, “BACnet GW-3 Configuration and Operation”, on page 25.

Once the BACnet GW-3 has been configured, refer to Section 3.2, “Connect the BACnet GW-3 to the NFN Network or FACP” on page 33 for more information.
Section 3 BACnet GW-3 Configuration and Operation

3.1 BACnet GW-3 Configuration

CAUTION:
Different sources of power are used in conjunction with this product. Disconnect all sources of power before servicing. This device and associated equipment may be damaged by removing and/or inserting cards, modules or interconnecting cables while this unit is powered. This damage may adversely affect the operation of this unit, but its effect may not be readily apparent.

3.1.1 BACnet GW-3 Configuration Overview

Perform the gateway configuration in this order:
- “BACNet Gateway Configuration Tool Installation” on page 25
- “Connect the Configuration Computer to the BACnet GW-3” on page 26
- “Prepare the Configuration Computer to Communicate with BACnet GW-3” on page 26
- “Log into the BACnet GW-3 for Configuration” on page 27
- “Configure the BACnet GW-3” on page 28
- “Connect the BACnet GW-3 to the NFN Network or FACP” on page 33

3.1.2 BACNet Gateway Configuration Tool Installation

The BACNet Gateway Configuration Tool CD-ROM is provided when the gateway is ordered. Use these steps as guideline to install the application onto the computer that has Windows 2000 or XP installed.

Step 1. Insert the CD-ROM into the CD-ROM drive on the computer that will be connected to the gateway so the gateway can be configured.

Step 2. From Windows Explorer or the Run command, select and start the setup.exe file that is located in the CD-ROM’s root directory. The installation program starts.

Step 3. Follow the displayed instructions to install the BACNet Gateway Configuration Tool.
3.1.3 Connect the Configuration Computer to the BACnet GW-3

If your configuration computer is on the same IP network you connected the BACnet GW-3 to in the section, Section 2.6, “Connecting BACnet GW-3 to an IP Network” on page 23, then your configuration computer is already connected to the BACnet GW-3. Proceed to Section 3.1.4, “Prepare the Configuration Computer to Communicate with BACnet GW-3” on page 26. Otherwise, refer to Appendix C, “BACnet GW-3 Local Configuration”, on page 49.

3.1.4 Prepare the Configuration Computer to Communicate with BACnet GW-3

Configure your configuration computer to communicate with the default BACnet GW-3 IP address of 192.168.1.2:

Step 1. From the Windows taskbar, click Start ⇒ Connect To ⇒ Show All Connections.
Step 2. Right-click your LAN connection, and then click Properties in the menu that appears.

Step 3. Select Internet Protocol (TCP/IP), and then click Properties.
Step 4. Record your current Internet Protocol (TCP/IP) property settings so you can restore them later.

Step 5. Click **Use the following IP address**, and then type *192.168.1.X* into the **IP address** field.

**NOTE:** *X* can be any number between 0 and 255 except for 2 (since the BACnet GW-3 default IP address is 192.168.1.2).

Step 6. Click **OK**, and then close all remaining open windows.

### 3.1.5 Log into the BACnet GW-3 for Configuration

**NOTE:** The BACNet Gateway Configuration Tool must run at a resolution of **1024 X 768** or greater.

Step 1. Launch the BACNet Gateway Configuration Tool by clicking **Start ➔ All Programs ➔ BACnet Gateway Config Tool** from the Windows taskbar.

Step 2. Click the **Address** field, and then click the default gateway IP address *192.168.1.2* in the menu that drops down.

Step 3. Click **File ➔ Login**...
Step 4. Type the default password, 00000000, and then click OK.

3.1.6 Configure the BACnet GW-3

Set Up the SNTP Server

Synchronizing with an SNTP server allows the BACnet GW-3 to keep accurate time.

**NOTE:** By default, the BACnet GW-3 synchronizes its internal clock with the NFN network time, or with the Fire Alarm Control Panel in the case of a direct connection. Configuring the SNTP server is only necessary if you want the gateway to synchronize with another server, such as an ONYXWorks® Workstation or an SNTP time server.

Step 1. In the left pane of the BACNet Gateway Configuration Tool under the Gateway heading, click **SNTP Configuration**.
Step 2. Click the SNTP Server Address field under the Value heading, and then type the address of the SNTP server.

Configure Time Zone Settings

Step 1. In the left pane of the BACNet Gateway Configuration Tool under the Gateway heading, click **Time Zone Configuration**.
Step 2. Use the fields under the Value heading to enter your local Greenwich Mean Time offset value as well as the appropriate information about the observance of Daylight Savings Time.
Configure IP Settings

Step 1. In the left pane of the BACNet Gateway Configuration Tool under the Gateway heading, click **IP Configuration**.

Step 2. Click the fields under the Value heading, and type the IP, Subnet Mask, and Gateway (router) addresses this BACnet GW-3 will use on your network.

Step 3. Click Apply to activate these settings.

The BACnet GW-3 reboots automatically.

**Restore Your Standard Internet Protocol (TCP/IP) Settings**

Step 1. From the Windows taskbar, click **Start ➔ Connect To ➔ Show All Connections**.

Step 2. Right-click your LAN connection, and then click **Properties** in the menu that appears.
Step 3. Select Internet Protocol (TCP/IP), and then click Properties.

Step 4. Enter the settings you recorded earlier into the Internet Protocol (TCP/IP) Properties dialogue, and then click OK to return your configuration computer to your IP network.

**Finalize the BACnet GW-3 Configuration**

> Log into the BACnet GW-3

Step 1. Click View ⇒ Refresh Gateway List to refresh the gateway address list.

Step 2. Click the Address field, and then, from the menu that drops down, click the IP address you assigned this BACnet GW-3.

Step 3. Click File ⇒ Login...

Step 4. Type the default password, 00000000, and then click OK.
The BACNet Gateway Configuration Tool now displays the remaining configurable settings for the BACnet GW-3. Click the fields under the Value heading to enter appropriate values, following the guidelines in the following steps.

**Gateway Properties**
- We recommend you select the *Life Safety* Notification Type if your system supports it. Otherwise, virtually all clients support Multi State notification.

- Set the NCM address to a nonzero number.

- If you are adding the BACnet GW-3 to a network that already includes another gateway or gateways, assign the Network Number based on the highest Network Number used by any gateway already on the network. The Network Number for the new BACnet GW-3 must be greater than the highest Network Number by *one thousand*. For example, if the network already includes a gateway with a Network Number of 1001, then the lowest Network Number which can be assigned to the new BACnet GW-3 is 2001.

**BBMD Configuration**
- If the BACnet GW-3 and the Building Management System (BMS) are connected to the IP network across different subnets, they must be connected through a BACnet Broadcast Management Device (BBMD). When using a BBMD, set the Foreign Device value to *True* and enter values for IP Address, Port and Register Time.
**Multiple Gateways**

- NFN networks with more than 15 nodes must be monitored using the Multiple Gateway option.
- When using this Multiple Gateway option, set the Multiple Gateway value to **True**, and enter a value for each network node to be monitored by this BACnet GW-3.

- You may enter up to 14 nodes for FACPs to be monitored, since the BACnet GW-3 can support 15 nodes including itself.

**Apply Settings**

Step 5. Once all BACnet GW-3 settings have been properly configured, click **Apply** at the bottom of the Value pane to apply the settings and reboot the gateway.

---

**NOTE:** If you are changing settings on a BACnet GW-3 previously configured with monitored nodes, this screen button will be labeled **Apply And Delete Objects**.
3.1.7 Viewing BACnet GW-3 Activity with the BACNet Gateway Configuration Tool

The Gateway Activity window displays information about panels, network objects and NUP events processed by the BACnet GW-3. This utility tracks up to the 4,000 most recent records. Store this information permanently by clicking Save.

NOTE: The NFN network must be stable with very few events in order for the discovery process to discover all objects upon initial configuration. After initial configuration, the BACnet GW-3 updates the network daily at its specified Network Update Time (the default time is 2:00:00).

It is helpful to launch the Gateway Activity window before connecting the BACnet GW-3 to an NFN network or directly to a Fire Alarm Control Panel, so you can monitor the messages the BACnet GW-3 generates in its initial Auto Discovery and Property Search routines. To open the Gateway Activity window:

Step 1. Log into the BACnet GW-3 (refer to “Log into the BACnet GW-3” on page 30).
Step 2. Click View ⇒ Gateway Activity.

The Gateway Activity window opens. Network traffic will affect the time required to populate the Gateway Activity window.

3.2 Connect the BACnet GW-3 to the NFN Network or FACP

The BACnet client workstation front end must conform to BACnet Standard Annex J for IP and support Device Objects, Binary Output Objects, and Multi-state Input or Life Safety Points/Zones. It is also required to write to Notification Objects and receive confirmed/unconfirmed event notification messages. For details, refer to Appendix A, “PIC Statement”, on page 41.
Find Your Fire System Connection Option

Once the BACnet GW-3 is connected to the IP network, connect it to either a fire alarm control panel or an appropriate network control module. Refer to Table 3.1, “BACnet GW-3 to Fire System Connection Options” for details.

NOTE: Make only one of these connections.

Table 3.1 BACnet GW-3 to Fire System Connection Options

<table>
<thead>
<tr>
<th>When Connecting...</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>...to a high speed NFN network consisting exclusively of High Speed compatible panels</td>
<td>Section 3.2.1, “Connecting BACnet GW-3 to a High Speed NFN Network Control Module” on page 35</td>
</tr>
<tr>
<td>...to an NFN network</td>
<td>Section 3.2.2, “Connecting BACnet GW-3 to an NFN Network Control Module” on page 37</td>
</tr>
<tr>
<td>directly to a fire alarm control panel to be accessed through the BACnet GW-3</td>
<td>Section 3.2.3, “Connecting BACnet GW-3 Directly to a Fire Alarm Control Panel” on page 38</td>
</tr>
</tbody>
</table>
3.2.1 Connecting BACnet GW-3 to a High Speed NFN Network Control Module

- Use a HS-NCM-W for a twisted pair wire connection.
- Use a HS-NCM-SF for a single mode fiber-optic cable connection.
- Use a HS-NCM-MF for a multimode fiber-optic cable connection.

Connecting the BACnet GW-3 to an HS-NCM-W/SF/MF allows the gateway to communicate with devices on a high speed NFN network. Connect an BACnet Gateway-3 to a High Speed Network Control Module using either of these methods:

- **USB to USB Cable Connection**

  Connecting the BACnet GW-3 to an HS-NCM-W, HS-NCM-SF or HS-NCM-MF allows the gateway to communicate with devices on a high speed NFN network. Connect the cable between the USB “A” port on a BACnet GW-3 board and the USB “B” port on an HS-NCM-W, HS-NCM-SF or HS-NCM-MF. Or, connect the cable between the USB “B” port on a BACnet GW-3 board and the USB “A” port on an HS-NCM-W, HS-NCM-SF or HS-NCM-MF.

![Figure 3.1 USB Connection](image)
**NUP to NUP Cable Connection**

A NUP to NUP cable is used to connect between the gateway and the NFN network. Connect the cable between to the BACnet GW-3 circuit board NUP “A” connector and an HS-NCM-W/SF/MF board NUP “A” connector.

![Diagram of NUP to NUP connection]

*Figure 3.2 NUP to NUP Connection*
### 3.2.2 Connecting BACnet GW-3 to an NFN Network Control Module

- Use an NCM-W for a twisted pair wire connection.
- Use an NCM-F for a fiber-optic cable connection.

Connecting the BACnet GW-3 to an NCM-W or NCM-F allows the gateway to communicate with devices on an NFN network.

**NUP to NUP Cable Connection**

Connect the cable between to the BACnet GW-3 NUP “A” connector and an NCM-W or NCM-F NUP connector.

![NUP to NUP Connection Diagram](image)

**Figure 3.3 NUP to NUP Connection**
3.2.3 Connecting BACnet GW-3 Directly to a Fire Alarm Control Panel

The BACnet GW-3 connects to Fire Alarm Control panels over NUP. Refer to Appendix B.1, “Direct Connect Node Type Compatibility”, on page 47 for a list of supported panels.

![Figure 3.4 NUP to NUP Connection](image)

3.3 Back Up BACnet GW-3

Backing up the BACnet GW-3 is important once the gateway is working properly. In some cases, if the gateway loses power while saving files, the gateway object database may be deleted. Without a backup file, the gateway will need to rediscover the network and the recipient list may also need to be set up again.

CAUTION: Auto Discovery and Property Search
To ensure the full object database is preserved, give the BACnet GW-3 time to complete its initial Auto Discovery and Property Search procedures before backing it up. For more information, please refer to “Viewing BACnet GW-3 Activity with the BACNet Gateway Configuration Tool” on page 33.

Step 1. Log into the BACnet GW-3 (refer to “Log into the BACnet GW-3” on page 30).
Step 2. Click **Tools ⇒ Backup Gateway**.
Step 3. Navigate to where you want to store the backup file, type a name for the file, and then click **Save**.

### 3.4 Restore BACnet GW-3

Follow these steps to restore a previously backed up BACnet GW-3.

**Step 1.** Log into the BACnet GW-3 (refer to “Log into the BACnet GW-3” on page 30).

**Step 2.** Click **Tools → Restore Gateway**.

**Step 3.** Navigate to where the backup file (.bnk) was saved, click on the file name, and then click **Open**.

The gateway is restored, and reboots automatically.
### 3.5 BACnet GW-3 Operation

#### 3.5.1 About BACnet GW-3 Start Up

On start up, the gateway auto discovers devices (panels and annunciators) and objects (detectors, modules, panels circuits, zones, loops, battery, AC Power, Ground, etc...) on NFN network it is connected to and creates BACnet objects according to your configuration.

Devices and objects are given names. Below are some format examples:

- An AFP1010 as node 142: `.Name = 142AFP1010` (BACnet Device Object)
- An NFS640 as node 234: `.Name = 234_NFS640` (BACnet Device Object)
- (Detector) Loop 5, Detector 83: `L005D083` (BACnet Life Safety Point or Multi-state Input Object)
- (Zone) Zone 134: `ZONE0134` (BACnet Life Safety Zone or Multi-state Input Object)
- Any Node, Loop 5, Control Module 12: `L005C012` (BACnet Binary Output Object)
- An AM2020 as node 120: `.Name = 120_AM2020` (BACnet Device Object)
- An NCM as node 11 connected to BACnet GW: `.Name = 011__BACGW` (BACnet Device Object)
- (Module) Loop 9, Module 120: `L009M120` (BACnet Life Safety Point or Multi-state Input Object)
- (Zone) Zone 1003: `ZONE1003` (BACnet Life Safety Zone or Multi-state Input Object)
- (Panel Internal Devices)--LOOP 8, LOOP10, BATTERY, ANNUN021, ACPOWER, PANEL (BACnet Life Safety Point or Multi-state Input Object)
Appendix A: PIC Statement

A.1 BACnet Protocol Implementation Conformance Statement (Normative)

(This appendix is part of this Standard and is required for its use.)

• Applications Software Version: 3.11
• Firmware Revision: 3.11
• BACnet Protocol Revision: 1.2

Product Description:

This product presents NOTIFIER® Fire Panel and Annunciator nodes (operating as part of a NFN network or stand-alone) and their associated objects as BACnet objects. Event notification for Alarms, Troubles and other states are sent to registered BACnet client workstations.

BACnet Standardized Device Profile (Annex L)

<table>
<thead>
<tr>
<th>Profile Name</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>BACnet Operator Workstation (B-OWS)</td>
<td>☑</td>
</tr>
<tr>
<td>BACnet Building Controller (B-BC)</td>
<td>☑</td>
</tr>
<tr>
<td>BACnet Advanced Application Controller (B-AAC)</td>
<td>☑</td>
</tr>
<tr>
<td>BACnet Application Specific PC Controller (B-ASS)</td>
<td>☑</td>
</tr>
<tr>
<td>BACnet Smart Sensor (B-SS)</td>
<td>☑</td>
</tr>
<tr>
<td>BACnet Smart Actuator (B-SA)</td>
<td>☑</td>
</tr>
</tbody>
</table>

BACnet Inter-operability Building Blocks Supported (Annex K)

<table>
<thead>
<tr>
<th>Profile Name</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS-RP-B</td>
<td>DS-RPM-B</td>
</tr>
<tr>
<td>DS-WP-B</td>
<td>DS-WPM-B</td>
</tr>
<tr>
<td>AE-N-I-B</td>
<td>AE-ACK-B</td>
</tr>
<tr>
<td>AE-ASUM-B</td>
<td>AE-INFO-B</td>
</tr>
<tr>
<td></td>
<td>DM-DDB-B</td>
</tr>
<tr>
<td>DM-DOB-A</td>
<td>DM-DOB-B</td>
</tr>
<tr>
<td>DM-LM-B</td>
<td></td>
</tr>
</tbody>
</table>

Segmentation Capability

• Segmented requests supported, Window Size 1024 max.
• Segmented responses supported, Window Size 1024 max.

Standard Object Types Supported - Life Safety Point/Life Safety Zone
### PIC Statement

**BACnet Protocol Implementation Conformance Statement (Normative)**

<table>
<thead>
<tr>
<th>Present Value</th>
<th>BACnet Enumeration</th>
<th>BACnetLifeSafetyState</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>IssQuiet</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>IssPreAlarm</td>
<td>PreAlarm</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>IssAlarm</td>
<td>Fire Alarm, Security Alarm (Life/Property), Critical Process Alarm (Life/Property), Medical Emergency</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>IssFault</td>
<td>Security Trouble, Fire Trouble, Non-Fire Trouble, Fire Device or Zone Disabled, Non-Fire Device Disabled</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>IssActive</td>
<td>Non-Fire Activation</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>IssSupervisory</td>
<td>Supervisory (Equipment), Supervisory (Guard's Tour)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tracking Value</th>
<th>BACnet Enumeration</th>
<th>BACnetLifeSafetyState</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>IssQuiet</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>IssPreAlarm</td>
<td>PreAlarm</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>IssAlarm</td>
<td>Fire Alarm, Security Alarm (Life/Property), Critical Process Alarm (Life/Property), Medical Emergency</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>IssFault</td>
<td>Security Trouble, Fire Trouble, Non-Fire Trouble, Fire Device or Zone Disabled, Non-Fire Device Disabled</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>IssActive</td>
<td>Non-Fire Activation</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>IssSupervisory</td>
<td>Supervisory (Equipment), Supervisory (Guard's Tour)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event State</th>
<th>BACnet Enumeration</th>
<th>BACnetEventState</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>EsNormal</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>EsFault</td>
<td>Security Trouble, Fire Trouble, Non-Fire Trouble, Fire Device or Zone Disabled, Non-Fire Device Disabled</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>EsOutOfRange</td>
<td>All status except normal and fault</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reliability</th>
<th>BACnet Enumeration</th>
<th>BACnetReliability</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>reNoFaultDetected</td>
<td>All status except normal</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>re_UnreliableOther</td>
<td>Security Trouble, Fire Trouble, Non-Fire Trouble</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mode</th>
<th>BACnet Enumeration</th>
<th>BACnetMode</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>IsmOff</td>
<td>Power-Up State</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>IsmEnabled</td>
<td>Set if point has been disabled and subsequently enabled since startup.</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>IsmDisabled</td>
<td>Fire Device or Zone Disabled, Non-Fire Device Disabled</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Silence State</th>
<th>BACnet Enumeration</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>ssUnsilenced</td>
<td>Audibles Unsilenced</td>
</tr>
<tr>
<td>1</td>
<td>ssAudiblesSilenced</td>
<td>Audibles Silenced</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operation Expected</th>
<th>BACnet Enumeration</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td>NA</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Maintenance Required</th>
<th>BACnet Enumeration</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>NA</td>
<td></td>
<td>NA</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event Enable</th>
<th>BACnet Event Transition Bit</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>ToOffNormal</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>ToFault</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Direct Reading</th>
<th>Boolean</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>TRUE</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status Flags</th>
<th>Boolean</th>
<th>BACnet Status Flags</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0,0,0,0</td>
<td>Normal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1,0,0,0</td>
<td>InAlarm</td>
<td>Fire Alarm, Security Alarm (Life/Property), Critical Process Alarm (Life/Property), Medical Emergency, PreAlarm</td>
<td></td>
</tr>
<tr>
<td>1,1,0,0</td>
<td>InAlarm, Fault</td>
<td>Security Trouble, Fire Trouble, Non-Fire Trouble</td>
<td></td>
</tr>
<tr>
<td>1,0,0,1</td>
<td>InAlarm, OutOfService</td>
<td>Fire Device or Zone Disabled, Non-Fire Device Disabled</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Out of Service</th>
<th>Boolean</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>TRUE</td>
<td>Fire Device or Zone Disabled, Non-Fire Device Disabled</td>
</tr>
</tbody>
</table>
### Standard Object Types Supported - Multi-state Input Standard Object Types

<table>
<thead>
<tr>
<th>Present Value</th>
<th>BACnet Enumeration</th>
<th>MFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Multi</td>
<td>Normal</td>
</tr>
<tr>
<td>2</td>
<td>Multi</td>
<td>Abnormal</td>
</tr>
<tr>
<td>3</td>
<td>Multi</td>
<td>Security Trouble, Fire Trouble, Net-Fire Trouble</td>
</tr>
<tr>
<td>4</td>
<td>Multi</td>
<td>Fire Device or Zone Disabled, Net-Fire Device Disabled</td>
</tr>
</tbody>
</table>

#### Event State

<table>
<thead>
<tr>
<th>Present Value</th>
<th>BACnet Enumeration</th>
<th>BACnetEventState</th>
<th>MFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Event</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Event</td>
<td>Security Trouble, Fire Trouble, Net-Fire Trouble, Fire Device or Zone Disabled, Net-Fire Device Disabled</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Event</td>
<td>Abnormal</td>
<td></td>
</tr>
</tbody>
</table>

#### Reliability

<table>
<thead>
<tr>
<th>Present Value</th>
<th>BACnet Enumeration</th>
<th>BACnetReliability</th>
<th>MFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Multi</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Multi</td>
<td>Security Trouble, Fire Trouble, Net-Fire Trouble</td>
<td></td>
</tr>
</tbody>
</table>

#### Status Flags

<table>
<thead>
<tr>
<th>Present Value</th>
<th>Boolean</th>
<th>MFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>TRUE</td>
<td>Normal</td>
</tr>
<tr>
<td>1</td>
<td>FALSE</td>
<td>Abnormal</td>
</tr>
</tbody>
</table>

#### Out of Service

<table>
<thead>
<tr>
<th>Present Value</th>
<th>Boolean</th>
<th>MFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>FALSE</td>
<td>Normal</td>
</tr>
<tr>
<td>1</td>
<td>TRUE</td>
<td>Abnormal</td>
</tr>
</tbody>
</table>
## Supported - Binary Output

<table>
<thead>
<tr>
<th>Present Value</th>
<th>BACnet Enumeration</th>
<th>BACnetLifeSafetyState</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>IssQuiet</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>IssPreAlarm</td>
<td>PreAlarm</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>IssAlarm</td>
<td>Fire Alarm, Security Alarm (Life/Property), Critical Process Alarm (Life/Property), Medical Emergency</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>IssFault</td>
<td>Security Trouble, Fire Trouble, Non-Fire Trouble, Fire Device or Zone Disabled, Non-Fire Device Disabled</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>IssActive</td>
<td>Non-Fire Activation</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>IssSupervisory</td>
<td>Supervisory (Equipment), Supervisory (Guard's Tour)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tracking Value</th>
<th>BACnet Enumeration</th>
<th>BACnetLifeSafetyState</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>IssQuiet</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>IssPreAlarm</td>
<td>PreAlarm</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>IssAlarm</td>
<td>Fire Alarm, Security Alarm (Life/Property), Critical Process Alarm (Life/Property), Medical Emergency</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>IssFault</td>
<td>Security Trouble, Fire Trouble, Non-Fire Trouble, Fire Device or Zone Disabled, Non-Fire Device Disabled</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>IssActive</td>
<td>Non-Fire Activation</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>IssSupervisory</td>
<td>Supervisory (Equipment), Supervisory (Guard's Tour)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event State</th>
<th>BACnet Enumeration</th>
<th>BACnetEventState</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>EsNormal</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>EsFault</td>
<td>Security Trouble, Fire Trouble, Non-Fire Trouble, Fire Device or Zone Disabled, Non-Fire Device Disabled</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>EsOffNormal</td>
<td>All statuses other than normal and fault.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reliability</th>
<th>BACnet Enumeration</th>
<th>BACnetReliability</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>reNoFaultDetected</td>
<td>All statuses other than trouble.</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>re_UnreliableOther</td>
<td>Security Trouble, Fire Trouble, Non-Fire Trouble</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mode</th>
<th>BACnet Enumeration</th>
<th>BACnetMode</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>IsmOff</td>
<td>Power-Up State</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>IsmEnabled</td>
<td>Set if point has been disabled and subsequently enabled since startup.</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>IsmDisabled</td>
<td>Fire Device or Zone Disabled, Non-Fire Device Disabled</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Silence State</th>
<th>BACnet Enumeration</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>ssUnsilenced</td>
<td>Audibles Unsilenced</td>
</tr>
<tr>
<td>1</td>
<td>ssAudiblesSilenced</td>
<td>Audibles Silenced</td>
</tr>
</tbody>
</table>

## Event Enable

<table>
<thead>
<tr>
<th>Event Enable</th>
<th>BACnet Event Transition Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ssOffNormal</td>
</tr>
<tr>
<td></td>
<td>ssFault</td>
</tr>
</tbody>
</table>

## Direct Reading

<table>
<thead>
<tr>
<th>Direct Reading</th>
<th>REAL</th>
<th>NA</th>
<th>% Alarm</th>
</tr>
</thead>
</table>

## Status Flags

<table>
<thead>
<tr>
<th>Status Flags</th>
<th>Boolean</th>
<th>BACnet Status Flags</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0,0,0,0</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1,0,0,0</td>
<td>InAlarm</td>
<td>Fire Alarm, Security Alarm (Life/Property), Critical Process Alarm (Life/Property), Medical Emergency</td>
</tr>
<tr>
<td></td>
<td>1,1,0,0</td>
<td>InAlarm, Fault</td>
<td>Security Trouble, Fire Trouble, Non-Fire Trouble</td>
</tr>
<tr>
<td></td>
<td>1,0,0,1</td>
<td>InAlarm, OutOfService</td>
<td>Fire Device or Zone Disabled, Non-Fire Device Disabled</td>
</tr>
</tbody>
</table>

## Out of Service

<table>
<thead>
<tr>
<th>Out of Service</th>
<th>Boolean</th>
<th>NFN State</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0</td>
<td>FALSE</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>TRUE</td>
</tr>
</tbody>
</table>
Standard Object Types Supported - Notification Class

Write Property/Add List element required for Intrinsic Reporting.

■ Data Link Layer Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BACnet IP, [Annex J]</td>
<td></td>
</tr>
<tr>
<td>BACnet IP, [Annex J], Foreign Device</td>
<td></td>
</tr>
<tr>
<td>ISO 8802-3, Ethernet (Clause 1)</td>
<td></td>
</tr>
<tr>
<td>ANSI/IEEE 802.1, 802.5, ARCNET (Clause 8)</td>
<td></td>
</tr>
<tr>
<td>ANSI/IEEE 802.1, 802.5, ARCNET (Clause 8)</td>
<td></td>
</tr>
<tr>
<td>Device Address Binding:</td>
<td></td>
</tr>
<tr>
<td>Is static device binding supported? (This is currently necessary for two-way communication with MS/TP slaves and certain other devices.)</td>
<td></td>
</tr>
<tr>
<td>Select - Yes</td>
<td></td>
</tr>
<tr>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Networking Options:</td>
<td></td>
</tr>
<tr>
<td>Select - Router, Clause 6 - List all routing configurations, e.g., ARCNET-Ethernet, Ethernet-MS/TP, etc. BACnet to Proprietary ARCnet Fire Network</td>
<td></td>
</tr>
<tr>
<td>Annex H, BACnet Tunneling Router over IP</td>
<td></td>
</tr>
<tr>
<td>BACnet/IP Broadcast Management Device (BBMD)</td>
<td></td>
</tr>
<tr>
<td>Does the BBMD support registrations by Foreign Devices?</td>
<td></td>
</tr>
<tr>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Select - No</td>
<td></td>
</tr>
<tr>
<td>Character Sets Supported:</td>
<td></td>
</tr>
<tr>
<td>Indicating support for multiple character sets does not imply that they can all be supported simultaneously.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Character Set Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSI X3.4</td>
</tr>
<tr>
<td>ISO 8809-1</td>
</tr>
<tr>
<td>ISO 10566-1 (ISO-2)</td>
</tr>
<tr>
<td>ISO 10566-1 (ISO-4)</td>
</tr>
<tr>
<td>BMP/Arcnet™ Decs</td>
</tr>
<tr>
<td>JIS C 6226</td>
</tr>
</tbody>
</table>

If this product is a communication gateway, describe the types of non-BACnet equipment/network(s) that the gateway supports:

Notifier Fire and Annunciator nodes compatible with NFN network v5.0 and later operating in a network or stand-alone configuration.
Appendix B: BACnet GW-3 Compatible Node Types

NOTE: The BACnet GW-3 requires that at least one node on the NFN network be an ONYX series panel. BACnet GW-3 does not operate on an NFN network with no ONYX series panels.

B.1 Direct Connect Node Type Compatibility

Refer to Section 3.2.3, “Connecting BACnet GW-3 Directly to a Fire Alarm Control Panel” on page 38.

Table B.1 Panel Communication Connection Table

<table>
<thead>
<tr>
<th>Supported Panel Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>NFS-320</td>
</tr>
<tr>
<td>NFS2-640</td>
</tr>
<tr>
<td>NFS2-3030</td>
</tr>
<tr>
<td>NCM</td>
</tr>
<tr>
<td>NFS-640</td>
</tr>
<tr>
<td>NFS-3030</td>
</tr>
</tbody>
</table>
Appendix C: BACnet GW-3 Local Configuration

NOTE: This procedure is only necessary if you are configuring an BACnet GW-3 using a Configuration computer that is not already on the same IP network as the BACnet GW-3. Refer to “Connecting BACnet GW-3 to an IP Network” on page 23.

NOTE: A direct connection requires that a cross over Ethernet cable to be made or purchased by the customer.

C.1 Direct Connection to the Gateway Board

Step 1. Connect the cross over cable between the configuration computer network card’s Ethernet connector and the BACnet GW-3 board’s Ethernet connector (refer to "Cross Over Cable Specifications").

![Diagram of Configuration Computer Direct Connection]

Figure C.1 Configuration Computer Direct Connection

Step 2. You have completed the connections, proceed to “Add the IP Subnet of the BACnet GW-3 into the Configuration PC” on page 28.

Cross Over Cable Specifications

This cross over cable will be directly connected between the configuration computer network card Ethernet connector and the BACnet GW-3 board Ethernet connector.
The cross over cable can be purchased or you can make one. Please use the following information for the correct pinout requirements for each end of the cable. EIA/TIA wire color-code standard 568B is applicable.

### Table C.1 Cross Over Cable (568B)

<table>
<thead>
<tr>
<th>RJ45 Pin # (END 1)</th>
<th>Wire Color</th>
<th>Diagram End #1</th>
<th>RJ45 Pin # (END 2)</th>
<th>Wire Color</th>
<th>Diagram End #2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>White/Orange</td>
<td></td>
<td>1</td>
<td>White/Green</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Orange</td>
<td></td>
<td>2</td>
<td>Green</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>White/Green</td>
<td></td>
<td>3</td>
<td>White/Orange</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Blue</td>
<td></td>
<td>4</td>
<td>Blue</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>White/Blue</td>
<td></td>
<td>5</td>
<td>White/Blue</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Green</td>
<td></td>
<td>6</td>
<td>Orange</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>White/Brown</td>
<td></td>
<td>7</td>
<td>White/Brown</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Brown</td>
<td></td>
<td>8</td>
<td>Brown</td>
<td></td>
</tr>
</tbody>
</table>
Appendix D: Glossary

B
NOTIFIER® BACnet Gateway-3 An interface that allows the NFN network to communicate with a BACnet network.

F
FTP File Transfer Protocol, used to back up the NOTIFIER® BACnet Gateway-3 database and download firmware for field upgrades.

H
HS-NCM-W/SF/MF High Speed Network Control Module, a network interface enabling the NOTIFIER® BACnet Gateway-3 to communicate with other NFN devices.

I
IP Address Logical address designating a node on an IP network with the format NNN.NNN.NNN.NNN, where NNN groups can be between 0 and 255.

NFN The network of Fire Alarm Control Panels. Ethernet - Local area network protocol.

T
Telnet An Internet protocol that allows you to communicate directly with another computer on the Internet by specifying the host name, port and terminal type.
Index

A
ANSI/ASHRAE 135-1995 7
architecture
  system 11
ARCNET 45

B
BACnet Configuration Tool
  installation procedure 25
BACnet Gateway
  Features 7
BACnet Gateway part number 15
BACnet Inter-operability Building Blocks 41
BACnet Standard Annex J for IP 7
Bacnet Standardized Device Profile 41
Binary Output Objects 7

C
Cabinet Installation 18
Character Sets Supported 45
Configuration computer
  connections 26
configuration computer
  direct connection 49

D
Data Link Layer Options 45
device
  BACnet names 40
Device Address Binding 45
Device Compatibility 8
Device Objects 7

E
EIA/TIA wire color-code standard 50
Ethernet
  Line Impedance 21
  Max Distance 21
Ethernet cross over cable
  specifications 49
Ethernet Network
  about 9

F
fiber-optic cable 22

G
Gateway
  assembly 15
configuration 49
  features 7
Hardware Installation 20
IP cable connection 23
Required Equipment 15
gateway
  configuration overview 25
Gateway board
  layout 17
Gateway Installation
  Overview 16

H
HS-NCM board 22

I
Installation
  Environmental Conditions 9
IP Address 51

L
Life Safety Points 7
Life Safety Zones 7
Line Impedance 21

M
Max Distance 21
Multi-state Input 7

N
NCM board 22
Network Cable Connection 35
Network Communication Module Installation 22
Network Interface Board 15
NFN Network Connections 23
Normative 41
Notification Class 45
Notification Objects 7
NUP
  Line Impedance 21
  Max Distance 21
NUP to NUP Cable 15
NUP to NUP Cable Connection 36, 37

O
object
  BACnet names 40
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>P</strong></td>
</tr>
<tr>
<td>PIC STATEMENT 41</td>
</tr>
<tr>
<td>PNET-1 15</td>
</tr>
<tr>
<td>Power Connections 20</td>
</tr>
</tbody>
</table>

**R**
- Related Documentation 8
  - RS232
    - Line Impedance 21
    - Max Distance 21

**S**
- Segmentation Capability 41
- Serial Configuration Tool
  - operating system 10
- Standard Object Types Supported 41
- Supported - Binary Output 44
- System Requirements 10

**T**
- twisted pair wire 22

**U**
- USB
  - Line Impedance 22
  - Max Distance 22

**W**
- Wiring
  - Power 20
Limited Warranty

Honeywell International Inc. warrants products manufactured by it to be free from defects in materials and workmanship for eighteen (18) months from the date of manufacture, under normal use and service. Products are date stamped at time of manufacture. The sole and exclusive obligation of Honeywell International Inc. is to repair or replace, at its option, free of charge for parts and labor, any part that is defective in materials or workmanship under normal use and service. All returns for credit are subject to inspection and testing at the factory before actual determination is made to allow credit. Honeywell International Inc. does not warrant products not manufactured by it, but assigns to the purchaser any warranty extended by the manufacturer of such products. This warranty is void if the product is altered or repaired by anyone other than Honeywell International Inc. or as expressly authorized by Honeywell International Inc. in writing, or is serviced by anyone other than Honeywell International Inc. or its authorized distributors. This warranty is also void if there is a failure to maintain the products and systems in which they operate in a proper and workable manner. In case of defect, secure a Return Material Authorization form from our Return Authorization Department.

This writing constitutes the only warranty made by Honeywell International Inc., with respect to its products. Honeywell International Inc., does not represent that its products will prevent any loss by fire or otherwise, or that its products will in all cases provide the protection for which they are installed or intended. Buyer acknowledges that Honeywell International Inc., is not an insurer and assumes no risk for loss or damages or the cost of any inconvenience, transportation damage, misuse, abuse, accident or similar incident.

HONEYWELL INTERNATIONAL INC. GIVES NO WARRANTY, EXPRESS OR IMPLIED, OF MERCHANTABILITY, FITNESS FOR ANY PARTICULAR PURPOSE, OR OTHERWISE WHICH EXTENDS BEYOND THE DESCRIPTION ON THE FACE HEREOF. UNDER NO CIRCUMSTANCES SHALL HONEYWELL INTERNATIONAL INC. BE LIABLE FOR ANY LOSS OF OR DAMAGE TO PROPERTY, DIRECT, INCIDENTAL OR CONSEQUENTIAL, ARISING OUT OF THE USE OF, OR INABILITY TO USE HONEYWELL INTERNATIONAL INC.’S PRODUCTS. FURTHERMORE, HONEYWELL INTERNATIONAL INC. SHALL NOT BE LIABLE FOR ANY PERSONAL INJURY OR DEATH WHICH MAY ARISE IN THE COURSE OF, OR AS A RESULT OF, PERSONAL, COMMERCIAL OR INDUSTRIAL USE OF ITS PRODUCTS.